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Micro Focus® Visual COBOL® for ISVs
Release Notes

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

* Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using either Microsoft's Visual Studio 2010 or Visual Studio 2012 integrated
development environments. Visual COBOL supports the development and deployment of both
managed .NET and native code applications.

Note: The product is available in two variants - Visual COBOL for Visual Studio 2010 , and Visual
COBOL for Visual Studio 2012.

Visual COBOL for Visual Studio 2010 and Visual COBOL for Visual Studio 2012 each target a
different version of the COBOL run-time system - COBOL Server and COBOL Server 2012,
respectively.

Ensure that after you've edited the project in the preferred version of Visual Studio, you compile
your source code in that version of Visual COBOL which targets the version of the COBOL run-
time in which you want your applications to run.

For example, if you build your application using Visual COBOL for Visual Studio 2010 you cannot
deploy the target files to COBOL Server 2012; you must use COBOL Server.

» Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

* Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

y Note: This document contains a number of links to external Web sites. Micro Focus cannot be

responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

v, Important: Application executables that were compiled using earlier Micro Focus products must be
=*' recompiled from the sources using Visual COBOL.

Micro Focus® Visual COBOL® for ISVs Release Notes
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System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

« 58MB for the Sentinel RMS license server
e 200MB for Micro Focus COBOL integration into Visual Studio

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

i Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The following platforms are supported:

32-bit Windows Platforms « Windows Server 2008 SP2
¢ Windows Server 2008 R2
¢ Windows Vista
¢ Windows XP Professional SP3 or later
¢ Windows 7
¢ Windows 8

64-bit Windows Platforms « Windows Server 2008 SP2

¢ Windows Server 2008 R2

¢ Windows Vista

* Windows XP Professional SP2 or later
¢ Windows 7

¢ Windows 8

Citrix and Terminal Server « Windows Server 2008 SP2
¢ Windows Server 2008 R2
¢« Windows 7
¢ Windows 8

Software Requirements

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

6 | System Requirements



v, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
=*' For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

If you choose to install using the full image, you need to install the following software beforehand:

e A full version of Microsoft Visual Studio 2010 or Microsoft Visual Studio 2012 (Premium, Professional,
or Ultimate), or the the respective version of the Microsoft Visual Studio Integrated Shell.

y Note:

« Microsoft Visual Studio Express Edition is not supported.

* You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If
you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell .enu.exe from the location where you installed the download.

The following functionality, tools and features have additional requirements:

Visual Studio IDE

* Microsoft Windows SDK is required if you are using Visual Studio Shell. See the Microsoft Download
Center and search for Windows SDK.

* Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.

» Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.

« Visual Studio 2010 Service Pack 1 is required if you are using Visual COBOL for Visual Studio 2010
and Visual COBOL for Visual Studio 2012 on the same machine. In addition, when building a native
COBOL project that contains resources you must replace the cvtres.exe in the bin and bin64
directories of your Visual COBOL installation with the version of the file which gets installed with Visual
Studio 2010 SP1. You can download Service Pack 1 for Visual Studio 2010 from the Microsoft
Download Center.

Java Compilation

e The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

set classpath=j dk-install-directory\lib\tools.jar

SQL CLR Integration for Visual Studio 2012
The following software is required to use the SQL CLR integration feature, which is specifically for the
development and deployment of COBOL stored procedures under Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:
» Either of the following:

« Visual Studio Shell 2012 and Microsoft SQL Server Tools (SSDT SDK)
e Visual Studio Professional 2012, Premium 2012, or Ultimate 2012

e Any of the following:

System Requirements
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e SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

e SQL Server 2012 targeting .NET CLR v4.0 framework (4.0), or .NET CLR v2.0 frameworks (2.0, 3.0,
3.5)

* SQL Server Azure targeting .NET CLR v4.0 framework (4.0) and also .NET CLR v2.0 frameworks
(2.0, 3.0, 3.5)

v+, Important: The SQL CLR Database project template is not supported with Visual Studio 2012.

=*' Projects based on the SQL CLR Database project template are automatically upgraded to use the
SQL Server Database project template when opened in Visual COBOL for Eclipse.

Windows Forms

» Microsoft Internet Information Service (IIS) is also required for generating Windows Forms test clients.

XML Extensions

« XML Extensions has the same requirements as RM/COBOL version 12 for 32-bit Windows. (See the
RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions may be used in
conjunction with Terminal Server.

System Requirements for Visual COBOL for Eclipse
(Windows)

Hardware Requirements

The disk space requirements for Windows are:

* Approximately 42MB for the Sentinel RMS license server.
* At least 680MB for Visual COBOL.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

The disk space requirements for UNIX/Linux are:

» Between 26 and 35 MB for the Sentinel RMS license server depending on the platform.
* Between 206 and 427 MB for Visual COBOL depending on the platform.

- Important: The UNIX installation requires extra disk space that equals the size of the product you

= install.

Operating Systems Supported

f Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The supported Windows platforms are:

¢ Windows XP 64-bit SP2

*  Windows XP 32-bit SP3

* Windows Vista SP1 32/64-bit

*  Windows 7 32/64-bit

* Windows 8 32/64-bit

* Windows Server 2008 SP2 32/64-bit
* Windows Server 2008 R2 32/64-bit

The supported UNIX and Linux platforms are:

8 | System Requirements



* POWER running AIX 6.1, 6.6, 7.2 - 32/64-bit

e Xx86-64 running Red Hat Linux 5.5, 5.8, 6.2, Oracle Linux 6.2 (Red Hat Kernel compatibility mode) -
32/64-bit

* Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2

e SPARC running Solaris 10, 11 - 32/64-bit

e x86-64 running SUSE SLES 11, 11 SP2, Oracle Linux 6.2 (Red Hat Kernel) - 32/64-bit

e 390 running SUSE SLES 11 SP1 - 32/64-bit

e Itanium running HP/UX 11.31 - 32/64-bit

Software Requirements

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

» If you use XML Extensions, it has the same requirements as RM/COBOL version 12 for 32-bit
Windows. (See the RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions
may be used in conjunction with Terminal Server.

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
= For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool _sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

System Requirements for Visual COBOL for Eclipse
(UNIX)

Hardware Requirements

The disk space requirements are:

* 33MB for the Sentinel RMS license server.
* Approximately 399MB for Visual COBOL.

f Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported

/ Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

e Xx86-64 running Red Hat Linux 5.8, 6.1, 6.2 - 32/64-bit
* Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2

System Requirements | 9
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* x86-64 running SUSE SLES 11, 11 SP2 - 32/64-bit

Software Requirements

Before installing this product, you must have the following software installed on your computer:

« Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries — glibc-devel (i686 version)

Check the Red Hat Web site for more information.
« To use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following bug fix updates
for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.€el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability.

f Note: On AlX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

e You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
=*' For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:
e Setthe JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit

Java installation or the installation terminates. For example, execute the following:
JAVA _HOME=j ava_instal |l _dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan. n
e Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA HOME/bin:$PATH

e Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.
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System Requirements for Visual COBOL Development
Hub

Hardware Requirements

The disk space requirements are:

» Between 26 and 33 MB for the Sentinel RMS license server depending on the platform.
» Between 206 and 427 MB for Micro Focus Development Hub depending on the platform.

f Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported

e« POWER running AIX 6.1, 6.6, 7.2 - 32/64-bit

e X86-64 running Red Hat Linux 5.5, 5.8, 6.2, Oracle Linux 6.2 (Red Hat Kernel compatibility mode) -
32/64-bit

e Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2

e SPARC running Solaris 10, 11 - 32/64-bit

e x86-64 running SUSE SLES 11, 11 SP2, Oracle Linux 6.2 (Red Hat Kernel) - 32/64-bit
e 390 running SUSE SLES 11 SP1 - 32/64-bit

e Itanium running HP/UX 11.31 - 32/64-bit

Software Requirements

Before installing this product, you must have the following software installed on your computer:

« Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries — glibc-devel (i686 version)

Check the Red Hat Web site for more information.
e To use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following bug fix updates
for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.€el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.e16.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.e16.i686.rpm
cyrus-sasl-lib-2.1.23-8.e16.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability.

i Note: On AlX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

System Requirements | 11
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* You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

¢, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
=" For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:
e Setthe JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit

Java installation or the installation terminates. For example, execute the following:
JAVA _HOME=j ava_instal |l _dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan. n
+ Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA HOME/bin:$PATH

e Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

System Requirements for COBOL Server for Windows

Hardware Requirements

The disk space requirements are:

* 42MB for the Sentinel RMS license server.
¢ About 170MB for COBOL Server.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

The following platforms are supported:

«  Windows XP 64-bit SP2

* Windows XP 32-bit SP3

¢ Windows Vista SP1 32/64-bit

e Windows 7 32/64-bit

* Windows 8 32/64-bit

« Windows Server 2008 SP2 32/64-bit
* Windows Server 2008 R2 32/64-bit
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Software Requirements

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

Before installing this product, you must have the following software installed on your computer:

1
' For local servers, you do not need to install it separately, as the setup file installs a new Visual

A version of the Microsoft .NET Framework that is targeted by your applications:

* Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager.

» Microsoft .NET Framework 4 is required if your applications use the ILCLR(4) Compiler Directive or if

they target the .NET Framework 4.

To download the Microsoft .NET Framework 4 click here.

« Microsoft .NET Framework 4.5 might be required for COBOL applications created with Visual Studio
2012.

i Note:

« If you do not target a specific version of the Microsoft .NET Framework, Micro Focus
recommends that you install version 4.
« .NET Framework 3 is provided with Windows Vista, Windows Server 2008.
* .NET Framework 3.5 is provided with Windows 7, Windows Server 2008 R2
Microsoft's Visual C++ 2010 Redistributable Package:

« To download Microsoft's Visual C++ 2010 Redistributable Package (x86) click here.
* To download Microsoft's Visual C++ 2010 Redistributable Package (x64) click here.

Note: If, when you install COBOL Server, the machine does not have Microsoft Visual C++ 2010
Redistributable Runtime already installed, it will be installed as required by COBOL Server. The
installation of Microsoft Visual C++ 2008 Redistributable Runtime will add a number of _dl1 files,
without digital signatures, into the winsxs directory.
Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

set classpath=j dk-install-directory\lib\tools. jar

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.

COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

System Requirements
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System Requirements for COBOL Server for UNIX

Hardware Requirements

The disk space requirements are:

+ Between 26MB and 54MB for the Sentinel RMS license server depending on the platform.
* Between 146MB and 350MB for COBOL Server.

f Note: The installation requires extra disk space that equals the size of the product you install.

Operating Systems Supported

* AIXPOWER 6.1/7.1 - 32/64-bit

e x86-64 running Red Hat Linux 5.5/5.7/6.1 - 32/64-bit

* Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2
e SPARC running Solaris 10 - 32/64-bit

¢ x86-64 running SUSE SLES 11/11 SP1 - 32/64-hit

* HPIA11.31 - 32/64-bit

COBOL for JVM is supported on the following platforms:

e HPIA 11.31 - 32/64-bit

e X86-64 running Red Hat Linux 5.6/6.1 - 32/64-bit
e SPARC running Solaris 10 - 32/64-bit

» x86-64 running SUSE SLES 11/11 SP1 - 32/64-bit

Software Requirements

Before installing this product, you must have the following software installed on your computer:

« Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries — glibc-devel (i686 version)

Check the Red Hat Web site for more information.

* To use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following bug fix updates
for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.€el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.e16.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.e16.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i1686.rpm

You do not need these updates if you use the full product setup file to install the product.

1. Java Platform Standard Edition (Java SE) 6 Update 27 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability.
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i Note: On AlX 6.1 v2, the minimum required version is Java 6.0 SR10.

You can download Java SE from www.oracle.com and install it anywhere on your machine.

1
]

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/

cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.

Before you start the installation, you need to set the environment as follows:

Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

set classpath=j dk-install-directory\lib\tools.jar

System Requirements
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Installation

i Note: If you are installing on Solaris, please read UNIX Installer Issues first.

UNIX Installer Issues

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory
To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerinstall.sh

License Server
On UNIX, you need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.| ocal domai n localhost
IP machi nel onghost name machi neshort host name

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Installing Visual COBOL for Visual Studio

Installation

i Note:

e This version of the product is a full install.
» Itis recommended to install this product using the Web Installer. The Web Installer helps you
install any missing prerequisite software and the product on your machine.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

* Visual COBOL and COBOL Server cannot co-exist on the same machine.

» Visual COBOL and Enterprise Developer cannot co-exist on the same machine.

« If, when you install Visual COBOL for Visual Studio 2010, the machine does not have Microsoft Visual
C++ 2010 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number of _dl1 files, without
digital signatures, into the winsxs directory.

» If, when you install Visual COBOL for Visual Studio 2012, the machine does not have Microsoft Visual
C++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The



installation of Microsoft Visual C++ 2012 Redistributable Runtime adds a number of .d11 files, without
digital signatures, into the winsxs directory.

< If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

* You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOQOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing Visual COBOL for Visual Studio

To use the Web Installer:

1. Double-click the VisualCOBOLVisualStudio2l1l webinstaller._exe file.

2. Click Start in the Web Installer dialog and follow the instructions to install the prerequisite software and
the product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Runthe VisualCOBOLVisualStudio2l.exe file and follow the wizard instructions to complete the
installation.

Note: If you are installing Visual COBOL for Visual Studio 2012 the files are
VisualCOBOLVisualStudio2l1l 2012 webinstaller.exe and
VisualCOBOLVisualStudio2l 2012.exe, respectively.

i Note:

e If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

« Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

* We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

» If you install JIDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing as an Upgrade

This release does not work concurrently with earlier releases and installing it uninstalls previous versions of
the product.

Before installing, check Installation Restrictions and Requirements.

Installation
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After Installing

You are now ready to run Visual COBOL. From the Windows taskbar click Start > All Programs > Micro
Focus Visual COBOL > Visual COBOL for Visual Studio.

f Note: The Start menu is not available on Windows 8. You use the Start screen to invoke programs.

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

y Note:

The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

« If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the | want to use local help button.

» Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

e If you do not wish to install Visual Studio 2010 SP1, you can install some third party tools that
enable the index or the fully expanding table of contents. Read http://kb.microfocus.com/
display/4/kb/article.aspx?aid=31484 for more.

* To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

» For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.

4. Click Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.

2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.

3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
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4. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL and Micro Focus
License Manager. Uninstalling only Visual COBOL does not automatically uninstall the Micro Focus
Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e The Micro Focus Product Nane folder in the Start menu - you can delete it manually.

o Y%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

 %Program Files%\Micro Focus - you can delete it manually.

Installing Visual COBOL for Eclipse (Windows)

Installation Restrictions and Requirements

Before starting the installation, you should consider the following:

e Visual COBOL and COBOL Server cannot co-exist on the same machine.
* Visual COBOL and Enterprise Developer cannot co-exist on the same machine.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing

To use the Web Installer:

1. Double-click the VisualCOBOLEcl ipse21_webinstaller ._exe file.

2. Click Start in the Installer window and follow the instructions to install the prerequisite software and the
product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Runthe VisualCOBOLEclipse2l.exe file and follow the wizard instructions to complete the
installation.

A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Name\eclipse directory. On older versions of Windows, Eclipse
might be installed in a different folder, such as for Windows XP, ini nstal | _di r\eclipse.
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i Note:

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Into Different Eclipse Packages

Micro Focus Visual COBOL uses Eclipse 3.7. If you have an existing Eclipse 3.7 installation, no further
action is necessary, but if you want to use Visual COBOL in other Eclipse packages based on version 3.6,
you must also install the Visual COBOL update site, and the RSE and AspectJ plugins. Follow the
procedure below to do this.

- Important: We recommend you back up all existing Eclipse configuration files first.

]

S

1. Install Visual COBOL as directed above.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

For Windows environments

1.

Extract the contents of the following . zip files in %ProgramFiles%\Micro Focus\Visual
COBOL\eclipse\installer to a temporary folder:

e ajdt _2.1.3 for_eclipse _3.7.zip

e RSE-runtime-3.3.zip

Copy the extracted folders to <your exi sting Ecli pse>\eclipse\dropins.

Copy %ProgramFiles%\Micro Focus\Visual COBOLUpdateSite to <your existing
Ecl i pse>\eclipse\dropins.

Rename each of the folders:

e Fromajdt 2.1.3 for_eclipse_3.7 to AJDTUpdateSite

e From RSE-runtime-3.3 to RSEUpdateSite

¢ From UpdateSite to COBOLUpdateSite

Move the the contents of the <your exi sting Ecli pse>\eclipse\dropins
\RSEUpdateSite\eclipse folder up a level (that is, to <your exi sting Ecli pse>\eclipse
\dropins\RSEUpdateSite) and delete the empty folder.

Copy the eclipse. ini file in WProgramFiles%\Micro Focus\Visual COBOL\eclipse
\installer to <your existing Eclipse>\eclipse, overwriting the existing file.

3. Restart Eclipse.

After Installing

If you

have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset

after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:
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Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
Click Window > Reset Perspective.

Click OK.

Reapply any customizations.

PO PR

Installing X Windows on Windows

Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server .exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.

4. Click Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.

3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.

4. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL and Micro Focus
License Manager. Uninstalling only Visual COBOL does not automatically uninstall the Micro Focus
Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installation
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Installing Visual COBOL for Eclipse (UNIX)

Installation

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing

To use the Web Installer:

1. Give the Web installer file execute permissions:
chmod +x webinstaller_visualcobol deveclipse 2.1 platform
2. Run the installer with superuser permissions:
./webinstaller_visualcobol _deveclipse 2.1 platform

If you don't run this as superuser, you will be prompted to enter the superuser password during the
install.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_deveclipse 2.1 platform
2. Run the installer with superuser permissions:
./setup_visualcobol_deveclipse 2.1 platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into Zopt/microfocus/Visual COBOL. A full version

of Eclipse, with the Micro Focus plugins already installed, is present in the Zopt/microfocus/
VisualCOBOL/ecl ipse directory.

To install in a different location use the —instal I location="Location" parameter to specify an
alternative directory location. For example:

-/webinstaller_visualcobol_deveclipse_2.1 pl atform -installlocation="ful |
pat h of new | ocati on"

or

./setup_visualcobol deveclipse 2.1 platform -installlocation="full path of
new | ocati on"

You can see details about which additional parameters can be passed to the install script if you enter
the —-help option.

f Note:

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the —
skipsafenet option, which skips the installation of SafeNet:

./setup_visualcobol _deveclipse 2.1 pl atform -skipsafenet

« To protect the SafeNet Sentinel installation from accidental updating you can create an empty

file named SKIP_SAFENET _INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL



While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set Up the Environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:
/opt/microfocus/VisualCOBOL/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -Version

v+, Important: These commands set the environment only for the current shell. You need to execute
=*' them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Start the Product
To start Eclipse:
1. Double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

Installing as an Upgrade

This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

* Move the R4 installation to a different location and install the latest version to the default install
location, Zopt/microfocus/Visual COBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command:
[ as root ] mv Zopt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4
2. Install the latest version as described in the section Installing.

« Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL 2.1 installer with the —installlocation option:

1. Execute the following command:

/lnstall File -installlocation="/opt/microfocus/VisualCOBOL2.1"
2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Installing Into Different Eclipse Packages

Micro Focus Visual COBOL uses Eclipse 3.7. If you have an existing Eclipse 3.7 installation, no further
action is necessary, but if you want to use Visual COBOL in other Eclipse packages based on version 3.6,
you must also install the Visual COBOL update site, and the RSE and AspectJ plugins. Follow the
procedure below to do this.
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i .,1 Important: We recommend you back up all existing Eclipse configuration files first.
1. Install Visual COBOL as directed above.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

For UNIX environments

1. Extract the contents of the following . zip files in Zopt/microfocus/VisualCOBOL/eclipse to
a temporary folder:

« ajdt _2.1.3 for_eclipse_3.7.zip

e RSE-runtime-3.3.zip

« UpdateSite.zip
2. Copy the extracted folders to <your exi sting Eclipse>/eclipse/dropins.
3. Rename each of the folders:

e Fromajdt_2.1.3 for_eclipse_3.7 to AspectJUpdateSite
e From RSE-runtime-3.3 to RSEUpdateSite
e From UpdateSite to COBOLUpdateSite

4. Move the the contents of the <your exi sting Eclipse>/eclipse/dropins/
RSEUpdateSite/eclipse folder up a level (that is, to <your exi sting Ecli pse>/eclipse/
dropins/RSEUpdateSite) and delete the empty folder.

5. Copy the eclipse.ini file in Zopt/microfocus/VisualCOBOL/eclipse/eclipse to <your
exi sting Eclipse>/eclipse, overwriting the existing file.

6. If necessary, edit eclipse. ini so that the -vm parameter is set to the requisite Java folder.

3. Restart Eclipse.

After Installing

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.

3. Click OK.

4. Reapply any customizations.

Configuring the Environment for Developing RDBMS
Applications on UNIX

f Note:

» If you are working with remote projects, you need to configure the environment before you start the
remote server process.

« On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.

4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate
linker options for the platform and the COBOL working mode:

w
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To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Uninstalling

To uninstall this product:
1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus Licensing
Manager or the prerequisite software. To completely remove the product you must uninstall the Micro
Focus Licensing Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing

To use the Web Installer:

1. Give the Web installer file execute permissions as follows:
chmod +x webinstaller_visualcobol _devhub 2.1 pl atform
2. Run the installer with superuser permissions:
-/webinstaller_visualcobol_devhub_2.1 pl atform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Alternatively, you can use the setup file and install the product as follows:

1. Give execute permissions to the setup file:
chmod +x setup_visualcobol _devhub 2.1 platform
2. Run the installer with superuser permissions:
./setup_visualcobol_devhub_2.1_pl atform
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If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into Zopt/microfocus/Visual COBOL.

To install in a different location use the -instal llocation="Location" parameter to specify an
alternative directory location. For example:

-/webinstaller_visualcobol _devhub 2.1 pl atform -installlocation="full path
of new | ocation"

or

-/setup_visualcobol _devhub 2.1 pl atform -installlocation="full path of new
| ocation"

You can see details about which additional parameters can be passed to the install script if you enter
the —help option.

i Note:

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the —
skipsafenet option, which skips the installation of SafeNet:

-/setup_visualcobol _devhub_2.1 pl atf or m -skipsafenet

« To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SK1P_SAFENET _INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_ INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or

shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set Up the Environment

When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
/opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:
cob -Version

v+, Important: These commands set the environment only for the current shell. You need to execute
=" them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Note: For information about the Visual COBOL Development Hub, check the help for Visual COBOL
for Eclipse that is available online on the Micro Focus Infocenter.

Installing as an Upgrade

This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

* Move the R4 installation to a different location and install the latest version to the default install
location, Zopt/microfocus/VisualCOBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:


http://documentation.microfocus.com

1. Execute the following command:
[ as root ] mv Zopt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4
2. Install the latest version as described in the section Installing.

« Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL 2.1 installer with the —installlocation option:

1. Execute the following command:

-/lnstall File -installlocation="/opt/microfocus/VisualCOBOL2.1"
2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Configuring the Environment for Developing RDBMS
Applications on UNIX

f Note:

» If you are working with remote projects, you need to configure the environment before you start the
remote server process.

« On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.

4. If working with Pro*COBOL/Cobsgl applications you need to set COBOPT. This sets the appropriate
linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Configuring the Remote System Explorer Support

The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.

Starting the Daemon

. Important: Before starting the daemon you must have the following on your UNIX machine:
P |

+ aversion of Perl

» aversion of Java

» the as (assembler) and 1d (linking) programs on the path, as specified by the PATH environment
variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, then specify another port number on the startrdodaemon command.

Installation
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The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <l ow port>-<hi gh port>]
where:

e <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,
$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.

« <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.

For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command (with superuser authority):
$COBDIR/remotedev/stoprdodaemon <port>

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hubfrom one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Uninstalling

To uninstall this product:
1. Execute as root the Uninstall_VisualCOBOL2.1.sh scriptin the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus Licensing
Manager or the prerequisite software. To completely remove the product you must uninstall the Micro
Focus Licensing Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstal IMFLicenseServer .sh scriptin the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.



You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing COBOL Server for Windows

Installation Restrictions and Requirements

Before starting the installation, you should consider the following:

* Visual COBOL and COBOL Server cannot co-exist on the same machine.

« If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

* You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_ CLASSES ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

« COBOL Server and COBOL Server 2012 can co-exist on the same machine.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing

To use the Web Installer:

1. Double-click the COBOLServer21_webinstaller_exe file.

2. Click Start in the Web Installer dialog and follow the instructions to install the prerequisite software and
the product.

Alternatively, you can use the setup file and install the product as follows:
1. Run the COBOLServer21.exe file and follow the wizard instructions to complete the installation.

Note: If you need to install COBOL Server 2012, the files you need to use are
COBOLServer21_2012_webinstaller.exe and COBOLServer21l_2012.exe, respectively.

f Note:

» If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

« Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

«  We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

« If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installation | 29


http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1

30

Installation

Installing as an Upgrade

This release does not work concurrently with earlier releases and installing it uninstalls previous versions of
the product.

Before installing, check Installation Restrictions and Requirements.

COBOL Server Installation Options

To install COBOL Server you run COBOLServer21.exe which contains a number of product -msi files
(Windows Installer packages). When run, COBOLServer21.exe performs some initial system checks then
sequentially installs the MSils.

COBOLServer21.exe can take a number of parameters, enabling you to specify a number of different
types of installation:

« Standard Installation

Format:
COBOLServer2l._.exe
Summary:
Full installation including License Manager, Vision, and COBOL Server. During installation you can
specify options including the location to which the components are installed.
« Non-interactive Installation

Format:
COBOLServer2l.exe /qgb
Summary:
Full installation, but the components are installed non-interactively using default options and
directories.
» Silent Installation

Format:
COBOLServer2l.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
» Modified Silent Installation

Format:

COBOLServer2l.exe /q /componentargs "Micro Focus COBOL

Server™ :"INSTALLDIR=d:\cobolrts"

Summary:

Full installation, but the installation is controlled by the /componentargs switch and the standard MSI
property INSTALLDIR. In the example above, COBOL Server is installed into d:\cobolrts.

y Note:

You can display the valid values for the /componentargs switch by using the /displayconfig switch:

COBOLServer2l.exe /displayconfig

* Log files that are created during installation are saved in the folder specified by the TEMP
environment variable.

* You can extract the component .msi files from COBOLServer21.exe by using the by using the /
extractcab switch:



start /wait COBOLServer2l.exe /extractcab

The extracted .msi files are saved in the SupportFi les subfolder.

After Installing

To open the help, select Start > All Programs > Micro Focus COBOL Server > Documentation from the
Windows Taskbar. From the left hand pane, select Micro Focus Developer > Micro Focus COBOL
Server.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.

4. Click Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.

2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.

3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.

4. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus COBOL Server and Micro Focus
License Manager. Uninstalling only COBOL Server does not automatically uninstall the Micro Focus
Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing COBOL Server for UNIX
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Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing

To use the Web Installer:

1. Give the Web installer file execute permissions once it downloaded:
chmod +x webinstaller_visualcobol _server 2.1 platform

2. Run the installer with superuser permissions:
-/webinstaller_visualcobol_server_2.1 platform

If you don't run this as superuser, you will be prompted to enter the superuser password during the
install.

Alternatively, you can use the setup file and install the product as follows:

1. Give execute permissions to the setup file:
chmod +x setup_visualcobol _server 2.1 platform
2. Run the installer with superuser permissions:
./setup_visualcobol _server 2.1 platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL environment is installed by default into Zopt/microfocus/Visual COBOL.

To install in a different location use the -instal llocation="Location" parameter to specify an
alternative directory location. For example:

-/webinstaller_visualcobol _server_2.1 pl atform -installlocation="full path
of new | ocation"

or

./setup_visualcobol _server 2.1 platform -installlocation="full path of new
| ocati on"

You can see details about which additional parameters can be passed to the install script if you enter
the —help option.

f Note:

» The installation of this product could affect the SafeNet Sentinel licensed components running on
your machine. During installation licensing is shutdown to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the —skipsafenet option,
which skips the installation of SafeNet:

-/setup_visualcobol_server_2.1 pl atform -skipsafenet

e To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL



While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file and
install Sentinel RMS server manually.

After Installing

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:
/opt/microfocus/VisualCOBOL/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -Version

-, Important: These commands set the environment only for the current shell. You need to execute
=" them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

Installing as an Upgrade

This release works concurrently with version R4 of Visual COBOL, so you do not need to uninstall it. There
are two options for installing the latest version in this case:

* Move the R4 installation to a different location and install the latest version to the default install
location, Zopt/microfocus/Visual COBOL.

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command:
[ as root ] mv Zopt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLR4
2. Install the latest version as described in the section Installing.

« Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL 2.1 installer with the —installlocation option:

1. Execute the following command:

/lnstall File -installlocation="/opt/microfocus/VisualCOBOL2.1"
2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL2.1/bin/cobsetenv

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.

You can use the following command line arguments to install silently on UNIX:
—silent -lacceptEULA

For example, execute:
webinstaller_fil ename —silent -lacceptEULA

or
setup_fil ename —silent -lacceptEULA

Installation
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Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Uninstalling

To uninstall this product:
1. Execute as root the Uninstall_VisualCOBOL2.1.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus Licensing
Manager or the prerequisite software. To completely remove the product you must uninstall the Micro
Focus Licensing Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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te:

This release uses the license keys for the Visual COBOL R4 release.

This release requires the latest version of SafeNet licensing software. See Software Requirements
in this document for more details.

If you are unsure about what your licensing policy is or what sort of license you require, consult
your System Administrator or Micro Focus SupportLine to obtain a valid license.

te: This package provides eight licenses for using Micro Focus Development Hub on all platforms.

Windows Use the Authorization Code, supplied with your delivery notice, to license your product. To do

UNIX

this:

1. Click Start > All Programs > Micro Focus License Manager > License Management
System.

The dialog box for the Micro Focus License System Administration Tool will be displayed.
2. Click the Authorize tab.
3. Enter your Authorization Code and click Authorize.
4. Close the Micro Focus License System Administration Tool.

If you wish to install the license silently, execute the following after the product has been
installed:

start /wait <install-dir>\bin\cesadmintool —term activate
Aut hori zat i onCode

The Micro Focus Licensing System is installed into the /var/microfocuslicensing
directory.

To license your software:

1. Run the Micro Focus Licensing Administration utility:
sh /var/microfocuslicensing/bin/cesadmintool.sh

f Note:

You need permissions to write to the license file which normally means you need
to log in as root.

» Make sure Java is on the PATH before you run the utility. See System
Requirements for more information.

2. Select an option as appropriate and press Enter:
If you have access to the Internet:

Select Online Authorization. You will be prompted to enter the Authorization Code
supplied with your delivery notice.

If you do not have access to the Internet:

You need the license strings. In order to obtain them, you need your Authorization Code,
your Machine Id and a machine with access to the Internet.

a. Choose Get Machine Id and press Enter.
b. Make a note of the information which is displayed.

Licensing Information
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c. On the machine which is connected to the Internet, open http://
supportline.microfocus.com/activation/ in a browser.

d. Follow the instructions to obtain the license strings and save them to a text file.
e. Copy the text file to the first machine on which you are installing the product.

f. Atthe command line, select Manual License Installation from the licensing options
and enter the full name of the file containing the license strings.

License for the Integrated Development Environment for Visual Studio or Eclipse

Your product is supplied with an evaluation license that typically enables you to use your product for 30
days. While you are using the evaluation license, a dialog will display when you start your product
prompting you to enter the Authorization Code. This code can be found in the Requested License Key
email that is supplied when you order your product. Depending on your product order, you might have
multiple license Authorization Codes. To obtain a full license for Visual COBOL, enter the code that is
printed under Visual COBOL - Visual COBOL for Visual Studio or Eclipse.

Note: If you have purchased a Visual COBOL timed license, the license management system may
show these as Trial licenses. This does not affect the license you have purchased.

i Note: An XSERV964 license key is supplied for ViewNow X Server.
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What's New

The following sections outline the new features that have been added in this release of Visual COBOL for
Eclipse.

New Features in Visual COBOL 2.1

ACUCOBOL-GT Data Types in Managed Code

ACUCOBOL-GT data types and sign() variants that were previously only available in native code are now
supported in managed code. Use the Compiler directives COMP1 and COMP2 to set ACUCOBOL-GT
behavior for those particular data types.

ACUCOBOL-GT Library Routines in Managed Code

ACUCOBOL-GT library routines that were previously only available in native code are now supported in
managed code.

Associating File Extensions With the COBOL
Language

This release includes enhancements to the way you associate file extensions and extensionless files with
the COBOL language.

if you are importing existing COBOL applications into Visual Studio, it is recommended that you create
associations with COBOL within the IDE for any extensions that are not traditionally used in COBOL.

Automatic Directives Detection and Setting

The IDE automatically determines and sets the COBOL dialect, and the CICS and SQL directives on local
or remote native COBOL projects. You can also start a directives scan from within COBOL Explorer -
select Determine Directives from the context menu for the projects or the COBOL source files. This
triggers a scan to determine the COBOL dialect, the CICS and SQL settings, and sets them as Compiler
directives on a file or project level respectively. At the end of the scan, you view the results and choose to
apply the changes.

Compiler Directives

The following new Compiler directives are now available

» DISPLAY - Defines the default behavior of standard DISPLAY statements.
¢ COMP1 - Specifies the behavior of a COMP-1 data item.
* COMP2 - Specifies the behavior of a COMP-2 data item.

« RESTRICT-GOTO - Generates a syntax error for GO TO statements that transfer control to outside of
the current section.

e ILSMARTRESTRICT - Limits the generation of properties in ILSMARTLINKAGE classes to non-
redefining elementary items.

The following Compiler directives have changed:
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« DATAMAP - Two new parameters allow you to display either the address or offset values for data items
in your program.

.int, .gnt @Nd .1or File Types Support

Support has been added within the IDE for compiling native COBOL applications to the Micro Focus legacy
formats . int and .gnt, and to package these files as a Micro Focus library file (. Ibr). Improvements
include:

< An option to compile all native COBOL projects to . int and .gnt code. You can set this on the
Application page in your project's properties.
« A new native COBOL project template, Micro Focus INT/GNT.

« An option to package the . int and .gnt files produced by the project as a Micro Focus . Ibr library
files.

« Improvements to the Net Express Project Import wizard that enable you to convert existing Net Express
projects to Visual COBOL projects that compile to . int and .gnt code.

Just-in-time debugging

Visual COBOL now supports "Just-in-time" debugging: when a run-time error occurs, or an application calls
CBL_DEBUGBREAK, the IDE can start automatically with the debugger attached to the failed process.

JVM Class Library

A new class library, com.microfocus.cobol . runtimeservices, has been introduced to help you
integrate JVM COBOL and Java in the same application.

The library contains the following classes:

CallableProgram Provides a class and annotation that you can use to create a class that can be called

from COBOL.

Interop Provides a class that contains helper methods for loading, calling and cancelling a
program.

RunUnit Provides a container class that allows you to use COBOL programs in a multi user/

session environment.

Full information on these classes is available in Javadoc format for integration in the Eclipse IDE.

Managed COBOL Enhancements

Delegates Delegates and events are now implemented on the JVM platform.

and Events This release provides support for combining delegates, using the METHOD keyword to

specify method groups, and implicit conversion from a method group or an anonymous
method to the suitable delegate type.

Handling The handling of invalid numeric data is controlled by a number of Compiler directives:
Invalid HOSTNUMMOVE, HOSTNUMCOMPARE and SIGNFIXUP. These directives were
Numeric previously only available in native code but are now supported in managed code.
Data



Resolving In this release, the Compiler attempts to resolve types to those defined in the current
Types compilation unit wherever possible. The Compiler will attempt to resolve such types to an
external name only if no suitable type exists in the current compilation unit. For example:
$set ilusingSystem"
class-1d MyNanmespace.EventHandler.
01 o type EventHandler.
end class.

In this release, 01 o type EventHandler. resolves to
MyNanespace .EventHandler and not to System._EventHandler.

Specifying  In previous versions of the products, properties declared using the PROPERTY keyword

Properties  on a data item were generated as final properties. Starting with this release, they are
generated as virtual properties by default. In order to make the properties final, you need
to specify the word FINAL following PROPERTY. This change may affect the generation
of Proxy classes, for example, if you are using WCF.

OpenESQL

SQL OpenESQL has been enhanced to support the the following new SQL compiler directive
Compiler options:
Directive . . .
Options DATE Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
specified.
TIME Controls the reformatting of date values in output parameters and in
input parameter character host variables when DETECTDATE is also
used.

DATEDELIM Specifies a single character as the delimiter between the year, month,
and day components to override the default delimiter determined by the
HCOSS DIALECT or DATE directive specification.

TIMEDELIM  Specifies a single character as the delimiter between the hour, minute,
and second components to override the default delimiter determined by
the HCOSS DIALECT or TIME directive specification.

TSTAMPSEP Specifies a single character as the separator between the date and time
parts of timestamp and date/time data.

SQL Server We now support Microsoft SQL Server 2012.

UNIX Platforms Support

Support for remote development and deployment of projects has been added for the Linux/390 platform.
Development Hub now supports Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2.

Main Features of Visual COBOL 2.1 for Visual Studio 2012

This version of Visual COBOL includes the following main features:

Integration with Visual Studio 2012

Visual COBOL provides support for the new features of Visual Studio 2012 and the Visual Studio 2012
Integrated Shell, including:
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Compatibility (Project
Round-Tripping)

.NET Framework 4.5
Compatibility

Reference Manager

Browse Code in Solution
Explorer Hub

Previewing Files in the
Code Editor

Loading Projects
Asynchronously

Search

Visual Studio 2012
Themes

Microsoft Help Viewer
2.0

The project round-tripping features enables you to use Visual Studio 2012 to
open and edit a project created with Visual Studio 2010 without upgrading or
changing anything. After closing the project, you can still open it in Visual
Studio 2010 to make further changes.

These are the requirements and the restrictions for using project round-
tripping with COBOL projects:

i Note:

e The version of Visual Studio 2010 being used to create and edit
projects must be Service Pack 1.

* For managed COBOL, the feature only works for applications that
target versions of the .NET Framework 2 to 4.

¢ There is a new format for COBOL SQL CLR projects in Visual
Studio 2012. Such projects created with Visual Studio 2010 will be
upgraded when you open them in Visual Studio 2012.

Provides support for creating managed COBOL applications that target
version 4.5 of the .NET Framework.

Supports the new Add Reference dialog box which ensures a faster way for
adding references to your projects.

Supports the enhanced Solution Explorer Hub without the in-built class/object
browser features.

Supports code preview for COBOL files which enables you to explore the
files in your project without opening them in the editor.

Enables you to load your source code in the IDE and start working on it faster
even when you have large applications.

Supports the enhanced search features across the IDE for COBOL projects.

Visual COBOL conforms to the new look and feel of Visual Studio 2012.

Provides support for the Micro Focus Help in Microsoft Help Viewer 2.0.

New SQL CLR Project Templates

The COBOL SQL CLR project template has a new format. COBOL SQL CLR projects created with Visual
Studio 2010 will be upgraded when you open them in Visual Studio 2012.

Windows 8
Supports Windows 8.

Coexistence with Visual COBOL for Visual Studio 2010

Visual COBOL 2.1 for Visual Studio 2012 and Visual COBOL 2.1 for Visual Studio 2010 can coexist on the
same machine. You can use either one of these versions to edit COBOL projects that are supported by the
project round-tripping feature in Visual Studio 2012.



Known Issues

Please refer to the Known Errors and Restrictions topic in the Product Information section of your product
Help.

In addition, please note the following:

ASP.NET

It is not possible to run ASP.NET Web Sites or Web Services on a production machine (one that has Micro
Focus COBOL Server installed) without an additional setup. This is because the production machine does
not contain development tools such as the COBOL Compiler. To workaround this, you need to do the
following steps:

1. Precompile the site before you deploy it using the Publish Web Site command in Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and delete the
Language=""COBOL" statement.

3. Edit the Web.config file with a text editor and delete the line which contains: <compiler
language=""COBOL™". . .

4. Ensure that a .NET Server license is installed using Apptrack.

COBOL Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement following the statement that
modifies the data on which that watchpoint is set.

Co-existing with Earlier Micro Focus Products

Run-time system A run-time system error occurs if either the COBCONFIG or COBCONFIG_

error due to environment variable is set when you run aVisual COBOL application or when you

COBCONFIG use Visual COBOL to edit or create projects and the configuration file it refers to
contains entries that are not valid for Visual COBOL.

For example, this might happen if you have Net Express or Studio Enterprise Edition
installed and either COBCONFIG or COBCONFIG_ is set for it.

To work around this issue, ensure that Visual COBOL is not running and then modify
the configuration file by doing one of the following:

¢ If the invalid tunable is not needed by another application, remove it from the run-
time configuration file.

e Add the following as the first line in the configuration file:
set cobconfig_error_report=false

¢ Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that
does not contain the invalid tunable for the particular session you are running in.

Creating COBOL Projects from Selection

The documentation on creating COBOL projects from selection specifies that the newly created project has
the same properties and references as the original project. You should also note that the new project has
the default build configuration for the selected project type.
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Known Issues

Debugging

There is an issue with "Wait for attachment" when you use Visual COBOL for Eclipse to debug applications
that run on some Linux/Unix platforms. Eclipse connects to the debugger on the remote machine, but might
not attach to the process to debug the code.

To work around this issue, ensure that on the remote machine the TMPDIR environment variable is unset
or has the same value for both Micro Focus Visual COBOL Development Hub server and for the running
process you wish to debug. The Micro Focus Visual COBOL Development Hub server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or indirectly using the daemon
which is started with the $COBDIR/remotedev/startrdodaemon script.

To check the variable used by the Micro Focus Visual COBOL Development Hub server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as the one used by the
process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be changed in the
remote shell and must be set before you start the daemon or server.

File Handling

*  When using a CGI/ISAPI application developed with the Net Express HTML Forms Designer in Visual
COBOL, you may receive an error “unresolved external symbol _NMCNVRTI” or “unresolved external
symbol _NMCNVRTO".

To work around this issue, add the corresponding .obj file to the Additional Directives in the project
properties, or use them from the command line to link the application: cbllink Filename.cbl
NMCNVRTI1.0BJ (or cbllink filename.cbl NMCNVRTO.OBJ, respectively).

» If you are accessing Vision files through the Vision file handler (as opposed to the default Micro Focus
File Handler) and you are upgrading from Visual COBOL version 2.0 to version 2.1, you must first
uninstall version 2.0, otherwise the Vision file handler may not function correctly.

Fileshare

A write of a record with an alternate key where the alternate key is the first value for that key may could
now return a 0/2 file status rather than a 0/0 status if a record with that alternate key value has been
deleted by uncommitted transaction (possibly the same transaction as that performing the write).

Installation

* A bug in 64-bit Windows 7 may cause the display of the Compatibility Assistant dialog box during the
installation of the product showing incorrectly that asImpclocate.exe and init2aslm.exe are not
compatible. The two utilities run properly and the installation is successful. To avoid receiving this
notification, run Windows update and install update KB978637 before installing this product.

< If, when you start Visual Studio, you receive a message box about a Micro Focus package load failures,
check that the Packages folder is on the PATH environment variable. If it is not, click No to disable
loading the packages.

If you accidently click Yes, you need to re-enable loading the packages, as follows:

1. Open a Visual Studio command prompt from the Start menu.
2. Enter the command:

devenv /ResetSkipPkgs
3. Reboot the machine.

This should resolve the problem. The PATH is set up correctly and the packages are found.



« Installing this release as an upgrade to a previous version of the product might take longer compared to
installing the product for the first time.

Native COBOL

On Windows XP, when building a native COBOL application in Visual Studio, a dialog may pop up with
error "Unhandled exception at 0xc0006866 in cobol.exe: 0xC0O000005: Access violation reading location
0xc0006866)". This is caused by Symantec antivirus runtime protection. To resolve this, you need to apply
the following fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Visual Studio IDE

* Inyour project properties, the Application page currently allows you to select any of the static methods
in the application as a Startup object. This is incorrect. You should always set only the first static
method or the program name as a Startup object in order for the project to build.

< In Visual Studio, the controls on the COBOL page in the project properties are not displayed for a WPF
project. To workaround this issue, open the Application page in the project properties and from the
drop-down list under Output type choose the same output type that was already selected. Close the
project property pages and save the project. The next time you open the project properties, the COBOL
page is properly displayed.

« When compiling a native COBOL application in Visual COBOL for Visual Studio which contains
resource files, you may receive compiler error "cannot open include file ‘pshpack2.h™. To workaround
this problem, ensure you have the Windows SDK installed on your machine, add the include folder in
the Windows SDK installation (by default, %ProgramFiles%\Microsoft SDKs\Windows\v7.0A
\include on Windows 7) to your include path, and recompile. Note: The Windows SDK is available as
a free download from Microsoft's Web site.

Visual Studio Shell
The following restrictions apply if you are using the Visual Studio Shell:

e On Windows XP, when building a managed COBOL application in Visual Studio, you may receive a
dialog box with error "The application failed to initialize properly (0xc0000005)". If you are running
Symantec antivirus runtime protection then this might be the cause for this issue. To resolve it, click
here to download a fix from Symantec.

* WCEF is not supported so the WCF demonstration programs do not work and the project templates for
WCF are not installed.

* There is no integrated designer for icon and bitmap files.

* The Windows SDK must be installed.

« Examples and demonstration programs that use languages other than COBOL do not work because
Visual Studio Shell doesn't support any other languages. This applies to the following demonstrations:

e CursorDemo

e InterfacingWithStdCOBOL
e LobDemo

e OrderStatusDemo
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Resolved Issues

The resolved issues that customers have reported are listed in this section. The numbers that follow each
issue are the Reported Problem Incident number followed by the Customer Incident Numbers (in
parentheses). RPIs that have numbers only (and no text) are included to confirm that the RPIs have been
fixed, since no further information is required.

* .NET Compiler

 .NET ESQL Support

e .NET Native Debug

« .NET Win ishcondition=""Form/WebForm
» Compiler

» Data Tools editor

» Documentation

« Eclipse IDE

» File Handling - External File Handler
* File Handling - Fileshare

e File Handling - Sort / JCL Sort
e JVM Compiler

* JVM Run-Time System

«  MVS REXX Emulation

¢ Run-Time System

e Setup Issues

* SQL: COBSQL

« SQL: DB2 ECM

¢ SQL: OpenESQL

* Vision File System

* Visual Studio IDE

« XDB DCLGEN Utility

+ XDB Server

e XML syntax support runtime

.NET Compiler

« When compiling for managed code, you can no longer use the ALTER, ON or EXHIBIT CHANGED
statements in class programs. You can only use these statements in procedural COBOL programs (i.e.
programs specified with the PROGRAM-ID header).

1084928 (2581987)

* When compiling to managed COBOL, we no longer produce an error for MOVE statements in which the
source is a PIC N field and the target is an object reference of type string.
1084133 (2572679)

e In managed COBOL, using the EXIT PARAGRAPH and NEXT SENTENCE statements in the same
paragraph could lead to bad control flow.
1084070 (2572411)

*  When compiling to managed code, the ASSIGN TO DISK FROM data-name clause (of the SELECT
statement) is now working correctly.

1085027 (2582960)
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A write to a record of a file defined in a class could result in the generation of a bad code if that record
was not referenced in your code.

1083955 (2570957)

The use of extended ACCEPT or DISPLAY statements in Windows applications (ilsubsystem"2") now
produces error COBCH1634: Extended ACCEPT/DISPLAY not allowed with a Windows GUI
executable (ILSUBSYSTEM"2"). Remove the syntax or change the output type of your application to
'‘Console Application'.

1084365 (2575702)

The directive NOIOCONYV no longer causes the compiler to produce system errors when compiling for
managed code.

1071930 (2359629)

When a pic x item is passed as a parameter to a method that is expecting a character
(System.Character or char in C#), conversion from the current locale to the relevant Unicode character
is performed. Previously, the conversion did not take place, causing corruption.

1084595 (2577800)
Access to indexers using zero-based indexing (e.g. display simplelndexer[2]) is now working correctly.

1084699 (2579210)

.NET ESQL Support

The OpenESQL pre-compiler no longer converts underscores in COBOL host variables in EXEC SQL
statements to dashes.

1085254 (2585445)

The default setting of SQL(BEHAVIOR) is MAINFRAME for versions of Visual COBOL and Enterprise
Developer 2.0 and later. If you are upgrading existing applications that support ADO.NET, use Mirosoft
SQL Server, and depend on cursors that are not explicitly declared as forward-only, read-only being
implemented as ADO.NET datasets, ensure that in the latest version of the Micro Focus products they
use the directive SQL(BEHAVIOR=UNOPTIMIZED), or update their code to declare cursors using the
scrolloption 'dataset’ that requires a dataset-based cursor.

1084942 (2582082)

.NET Native Debug

JIT debugging of 64-bit processes now works correctly in Visual Studio.
589153 ()

.NET WinForm/WebForm

Using the Ul to add COBOL switches or environment variables to a COBOL Web Application (right-click
the configuration file in Solution Explorer and select Edit) no longer causes a configuration error when
you run the application.

1082871 (2558133)

Compiler

The DBCSSOSI directive now compiles correctly.

590357 ()

DISPLAY MESSAGE BOX ... RETURNING syntax now returns an E-level error message stating that it
is unsupported in this COBOL system.

584600 ()
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You can now configure the DATAMAP clause to output either addresses or offsets. DATAMAP(ADDR)
or DATAMAP with no option shows addresses. DATAMAP(OFFSET) shows offsets. Compile managed
COBOL code sets DATAMAP(OFFSET) at the end of directive processing as addresses are not
available for managed code.

1054182 (2093752)

Compilation of ACU DISPLAY windowing syntax will no longer receive spurious internal error messages
during a background syntax check.

591227 ()

Compiling with a large number of ADDSYN directives specified now works as expected.

1083917 (2567767)
The maximum value for the PAGE LIMIT clause has been increased from 999 to 9999.

1084391 (2576431)

DISPLAY(CONSOLE) is a new directive available to override the behavior set by RM or ACU directives,
so that standard DISPLAY syntax is processed as standard ANSI DISPLAYS, directed to CONSOLE.
RM and ACU directives set DISPLAY(CRT) immediately, allowing you to set DISPLAY(CONSOLE)
after either of those directives, if required.

1084496 (2577799)

A compiler bug that produced illegal int-code for “call ... returning pointer-item" under DIALECT(RM)
has been fixed.

1085375 (2586367)

Data Tools Editor

The Data File Editor now allows editing of an EBCDIC data file on a DBCS OS.
1083716 (2567163)

Documentation

Information detailing the process of XML-enabling COBOL applications that was previously left out of
the Visual COBOL documentation has been reinstated and is now available under Programming >
COBOL Programming > XML Input/Output.

1084142 (2573343)

When entering the path of the IBM MQ libraries for the ES_MQ_LIB and ES_MQ_LIB_XA environment
variables, in AIX environments the library must be an object inside a shared object.

1084692 (2578515)

Eclipse IDE

Resolved Issues

Specifying "use(cobol.dir)" in the COBOL build settings no longer generates errors when a program is
open in the Editor.

1082324 (2548143)

The values that the Variables View shows when you debug with "Display hexadecimal values" or
"Display byte values" settings enabled have been changed.

589220 ()

You can now specify in the IDE whether directories that you add to the project should be added to the
copypath. You configure this in the project's properties under Micro Focus COBOL > Build Paths, and
on the Copybook Paths tab.

589096 ()



File Handling - External File Handler

Reading IDXFORMAT"9" records non-transactionally over fileshare no longer causes any issues.

1083646 (2566578)
When opening a mainframe file for input, the file is now not optional as per the mainframe.

1082362 (2506971)

When attempting to OPEN 1/O a read-only file using the RM/COBOL File Handler, a 37, 07 error
message is displayed if the program is running in ANSI85 mode. The error message is not displayed if
the program is running in ANSI74 mode.

1084329 (2573607)
Cobfhrepro now works correctly when session id is specified.

590271 ()
Invalid XML syntax in MF.MFFH.XML has been corrected.

589406 ()
The maximum field length that MFSORT supports for PD summary fields is extended from 9 bytes to 18
bytes.

1084961 (2581353)

File Handling - Fileshare

If you are accessing RM/COBOL files through Fileshare, the RETRYLOCK option is now working
correctly.

1084744 (2579930)
Closing a file using FSVIEW now correctly removes the file from fileshare's open file table.

587706 ()
The FSVIEW option 'stats get' gives the statistics for current users, peak users, file opens and peak file
opens. The corresponding FSVIEW API is FSV-C-get-stats.

1083664 (2567737)
FSVIEW will no longer process the last command in a command file twice.

589764 ()

File Handling - Sort / JCL Sort

The informational "Operand 'VLSHRT' Ignored" message has been removed from the sort sysout.

1083225 (2562501)
Using SYMNAMES sometimes caused SORT to use the wrong field position and lengths.

1083320 (2563738)
Data format Fl is now supported in the OUTREC edit fields section.

1083495 (2565051)

SORT now works correctly when there are concatenated VB files with different record lengths in
SORTIN.

1084194 (2573990)

SORT now gracefully handles the error when there is an INCLUDE/OMIT condition with invalid HEX/
Binary digit.

1084231 (2574465)
SORT now ignores the operand 'WORK' along with its value.

1081023 (2533397)
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A sort using SORTTEMPSPACE no longer ever results in a COBRTS 252 error.

1081943 (2546898)
CENTWIN and Y2PAST are now supported as PARMS.

1080717 (2531364)
The MFSORT help screen now shows that OPTION is supported.

590260 ()

SORT worked incorrectly for multiple fields to be converted in INREC/OUTREC/OUTFIL OVERLAY
syntax.

1084481 (2577157)

The TOTAL field length calculation now works correctly when TOTALS are zeros.

1082887 (2558079)
Trailers are now included in the SYSOUT outfil record count.

1084193 (2573272)
Records following HEADER2 and HEADER3 will now be the correct length.

590270 ()

Header lengths are now calculated correctly, taking line feeds into account instead of giving a
SORTO099I error. Headers will now be printed for outfiles that do not have any records.

1083701 (2565909)

SORT now works correctly when SYSIN is given as LSEQ PDS Member.

1082529 (2550678)

When using MFJTOOL with a VB input file, an appropriate error is thrown when the output file is not VB
or has not worked successfully when the output file is VB. Previously, a COBRTS 139 error was thrown.

1084567 (2577626)
Sort now works correctly when OPTION COPY is given before the SORT FIELDS in SYSIN.

1083679 (2565053)

SORT caused different sort processing for large sort cards. This has been fixed so SORT now returns
an error message and exits the sort processing when the sort card has more than 1024 INCLUDE/
OMIT conditions.

1084065 (2571660)

When using MFSORT, smaller records are padded to the size of the minimum record length of a VB file
and the record length is changed to the minimum of sortout.

1082943 (2554482)

Sort now displays HEADER?2 at the start and TRAILER?2 at the end of each page.

1083702 (2566545)

JVM Compiler

Resolved Issues

Java verification errors or incorrect program flow occurring in very large JVM COBOL programs is now
fixed. Previously, in very large programs, the compiler would process GO TO statement incorrectly, and
could jump to the wrong program locations.

1084569 (2578716)
Some problems with the use of nested classes defined in COBOL have been resolved.

1083183 (2561420)



JVM Run-Time System

A stack overflow no longer occurs if you execute a call to a method inside a constructor and this method
contains a COBOL statement. Previously, the runtime would jump back to the constructor and go into a
loop, producing a stack overflow.

1083181 (2561418)

The JVM COBOL library routines CBL_DIR_SCAN_ now return the correct results when searching for
directories.

590261 ()

MVS REXX Emulation

The DATE() function now formats the year correctly when converting between a Julian and a standard
date format.

1083437 (2564240)

The LISTDSI external function now correctly sets values for the SYSREFDATE and SYSMGMTCLASS
variables.

1084902 (2581611)

Run-Time System

The call MVS_REGISTER_DDNAME is an MFE-only call used by the IDE. FileHandler no longer calls
this routine.

1083028 (2559292)

IF NUMERIC validation of COMP-3 slack nibbles (when there is an even number of digits in the picture
clause) is now done in a way that is compatible with that on the mainframe.

1083801 (2569340)

The RUN program now accepts command line arguments of up to 1023 characters long.

1083215 (2561567)

When running a full-screen application inside a terminal emulator on Linux, the actual size of the
terminal is read at startup and reread when the terminal is resized. This behaviour is also supported on
AIX, HP/UX, and Solaris. The Micro Focus vt220 terminfo entry now correctly describes a 24-line
display. A vt220-25 terminfo entry is included for compatibility with the previous behaviour.

1084817 (2579335)

Setup Issues

When working on managed SQL applications, you no longer receive syntax check errors caused by
some COBOL SQL .dll files that were previously missing.

1084318 (2575613)

SQL: COBSQL

The Cobsql preprocessor was updated to no longer misinterpret WORKING-STORAGE items whose
definitions were spread across multiple source lines.

1080078 (2507684)

The Cobsql preprocessor has been updated to correctly process variables defined as USAGE COMP
after an EXEC SQL INCLUDE SQLCA when the CP preprocessor directive NOSQL is specified.
1084463 (2577593)

The Cobsql preprocessor has been updated to correctly process ProxCOBOL-generated data items
when the first WORKING-STORAGE variable in user code contains a VALUE clause with the literal
value on a separate source line.
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1084753 (2579264)

SQL: DB2 ECM

e The DB2 pre-compiler now generates GOBACK instead of STOP RUN at the end of program source,
so that poorly coded programs do not fail when running under IMS or other transaction monitors.

1083235 (2559616)

SQL: OpenESQL

* The OpenESQL preprocessor has been updated such that when a program or application is compiled
with the SQL(DBMAN=ADO) compiler directive, the calls generated do not modify user data when a null
value is returned.

1083563 (2561563)

e The OpenESQL preprocessor no longer accepts singleton select statements that have no INTO clause,
or host variables that are not preceded by a colon, apart from SQLDA references in dynamic SQL. In
rare cases where a singleton select without an INTO clause is required, code it by placing the SELECT
statement inside of a BEGIN/BEND block.

1084430 (2576585)

« The ODBC Compiler did not identify specialized classes such as ENUMS, and incorrectly generated
SQL interface code for them that caused Compiler errors. The ODBC Compiler has been enhanced so
that it no longer generates SQL interface code for those classes.

1083144 (2561349)

« Previously, the SQL pre-compilers did not always recognized the EXEC SQL INCLUDE statements
during the syntax checking phase and returned incorrect error messages.

1085057 (2582967)

Vision File System

« When you configure your application to return RM/COBOL file status codes, by setting
COBFSTATCONV=rmstat, the codes returned are ANSI'85 codes.

1082469 (2553438)

Visual Studio IDE
» Compile extensionless COBOL files with the IDE no longer fails.

591781 ()

« Previously, if you started debugging using CBL_DEUGBREAK and there was a COBOL source file
open in the editor, when you stopped debugging its dictionary file (.idy) was not being released. This
resulted in any subsequent builds and rebuilds failing. This problem has been resolved.

588696 ()

* The IDE no longer ignores certain Run-Time System errors from the Compiler which previously caused
the build to fail without an explanation.

591692 ()

* The native COBOL projects in Visual Studio have been enhanced so that you can now build them to
multiple executables - each COBOL program in the project producing a separate executable.

590335 ()

« Command line arguments are now passed to the program when started via the 'Start without
Debugging' option in the Visual Studio IDE.

568188 ()
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* You no longer receive an error message when adding an event handler to an object in a COBOL WPF
project if the .xaml code behind file includes a class that does not have methods in it.

591072 ()

« A new setting has been added to the COBOL tab in the project properties, "Generate listing option",
which produces an .Ist file in a Listing subfolder in the project directory. The "Generate directives file"
setting now generates the directive file in the project output directory.

1077662 (2494484)

« Previously, Visual Studio used to always rebuild the entire project after you changed the project
properties or added files when there were build error. This has been changed so that during subsequent
builds Visual Studio only rebuilds the files that are out-of-date.

1084393 (2576400)
« There is now a build summary report for projects that compile to multiple output files.

1084506 (2578006)

» Using drag and drop in Solution Explorer to move a file from one project to another no longer leaves a
copy of the file in the original project directory on the disk.

592120 ()

» A problem with using drag and drop to add files to projects in Solution Explorer has been resolved. It
now correctly creates copies of the files in the project folder when the CTRL button is pressed.

567446 ()

XDB DCLGEN Utility

« A protection violation sometimes occurred when you used the XDB Declaration Generator tool on 64-bit
Windows platforms.

591030 ()

XDB Server

e Support has been added to enable the execution of DESCRIBE INPUT statements.

1079821 (2508551)
« A mutex deadly embrace no longer results in a server hang.

1085199 (2583889)

XML syntax support runtime

* Anissue with the PREXML preprocessor has been resolved and it now does not truncate data names
longer than 30 characters.

1085342 (2586384)

« In previous releases, the documentation for XML Input/Output was missing from the online help. This
documentation is now included in the online help.

1084119 (2572393)
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The WebSync service, where you can download fixes and documentation updates.
« The Knowledge Base, a large collection of product tips and workarounds.
« Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

y Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

e The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

e Your operating system version number and details of any networking software you are using.
* The amount of memory in your computer.

« The relevant page reference or section in the documentation.

« Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mFsupport from a directory where you have write permissions.

This creates a log file, mfpol I . txt, in that directory.
4. When the script finishes, send the mfpol I . txt file to your Micro Focus SupportLine representative.

i Note:

If COBDIR is set to a location which does not contain etc/cobver, the script outputs the contents
of Zopt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.
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Disclaimer

Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2012. All rights reserved.
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